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Guide to Digimarc for Packaging Extension for Adobe Illustrator

Those involved in production 
design and prepress with a 
focus on packaging

Introduction
Digimarc for Packaging is an extension for Adobe® Illustrator® that enables 

production designers and premedia professionals to create connected packaging 

by enhancing packaging artwork with Digimarc Barcode. 

Essential Concepts

Digimarc for Packaging enables you to apply Digimarc Barcode to qualified 

layers of artwork in an Illustrator file. A qualified layer contains artwork that has 

been embedded and then rasterized at 300 DPI. For example, if a layer links to 

an external Photoshop image, you must embed and rasterize the layer before 

enhancing it. If a layer consists of vector artwork such as an area containing a 

spot color, you only need to rasterize it. 

When you enhance a layer, Digimarc Barcode is applied to an automatically-

generated duplicate of the original layer, leaving the original layer unchanged, 

enabling you to experiment with different enhancement techniques and 

parameters to achieve optimal readability with minimal visibility of Digimarc 

Barcode. 

Related Reading

For more information on enhancing packaging with Digimarc Barcode, see the 

following guides:

• Techniques for Enhancing Packaging with Digimarc Barcode presents 

techniques for those enhancing packaging. 

• Enhancing Your Brand with Digimarc Barcode discusses Digimarc Barcode 

technology and its interactions with printing processes, package design, 

scanners, smartphone cameras, and more.

System Requirements
Digimarc for Packaging requires:

• macOS 10.12 or later

• Adobe Illustrator CC 2017 or later
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Launch the Extension
Open Digimarc for Packaging by navigating to Window > Digimarc > Digimarc for Packaging.

View Digimarc for Packaging Help
You can view this document within Illustrator by navigating to Help > Digimarc > Digimarc for Packaging.

Sign In to Digimarc Barcode Manager
When you launch Digimarc for Packaging for the first  

time, or if you have previously signed out, you are 

prompted to Sign In to the Digimarc Barcode Manager.

To sign in, enter a Username and Password associated 

with the account that has access to the GTIN-14, 

UPC-E, or GIAI code to be added to the artwork, and 

then click Continue. 

If you have difficulty signing in, click Account Help 

to open the Digimarc Barcode Manager in your web 

browser. For more information, see the Guide to Digimarc Barcode Manager.

Once you sign in, your credentials are stored in the keychain. The next time you open Adobe Illustrator the extension 

automatically signs in to the Digimarc Barcode Manager using the stored credentials.

If you want to sign out of the Digimarc Barcode Manager, click the Digimarc for Packaging panel menu and select Sign Out. 
This removes stored credentials and requires you to sign in again.

Barcode Search
The Barcode Search is displayed if you are signed in 

to the Digimarc Barcode Manager and are working 

with a document that does not already have a Digimarc 

Barcode associated with it.

Enter a valid GTIN-14, UPC-E, or GIAI, and then click 

Search. The extension searches through all your 

associated accounts for a matching Digimarc Barcode. 

If multiple results are found, you are prompted to 

select the one you want.
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Barcode Details
If a Digimarc Barcode is found, or if the artwork  

already has a Digimarc Barcode associated with it, the 

Barcode Details view opens.

Barcode Resolution: The Digimarc Barcode Resolution 

is measured in watermark elements per inch (WPI) and 

may be set at 150 WPI (the default) or 75 WPI. Click 

Change Resolution and select either 75 or 150. This 

resolution will also be preselected the next time you 

begin enhancing a file.

Review the details, and then click Continue.

If a Digimarc Barcode is not found, or if there are any 

issues, a message displays with more information. 

NOTE: Once you continue to the Dashboard, the barcode 

details and resolution cannot be changed.

The Dashboard
The Dashboard is where you manage artwork elements for enhancement.

NOTE: Depending on the barcode type (Packaging, GIAI, or Packaging + Custom Field) your Dashboard and Enhancement Op-

tions will look slightly different than shown here.

1 The Elements panel lists the selected elements and their status:

 - A blue Digimarc icon indicates an enhanced element. 

 - A gray Digimarc icon indicates a configured, unenhanced element. 

 - No icon indicates an unconfigured, unenhanced element.

The Technique column displays the enhancement technique specified in Enhancement Options:
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 - Process color icons indicate the multi-channel technique applied in the CMY, CMYK, or MYK channels.

 - Plus and minus icons indicate positive or negative binary techniques.

 - A gray gradient icon indicates the single channel technique.

The Parameters column displays the enhancement parameters specified in Enhancement Options:

 - S indicates the enhancement strength. 

 - MD indicates the minimum dot percentage. 

 - (Low), (Med), and (High) indicate the setting selected for Reduce near Min Dot.

 - Zero Ink indicates Protect Zero Ink is selected.

 - HL indicates Reduce in Highlights is selected.

 - DD indicates the dot density of a binary pattern.

 - DS indicates the dot size of a binary pattern.

2 The panel menu allows you to sign out of the Digimarc Barcode Manager.

3 The Elements field displays the number of elements in the Dashboard.

4 Buttons are enabled only when applicable:

  Edit Enhancement Options – Opens the Enhancement Options window to modify settings of the selected 

element. You can also open the Enhancement Options dialog by double-clicking an element.

  Delete Enhanced Layer – Deletes the enhanced layer of the selected element from the Layers palette. The 

selected element’s status changes from blue to gray, but retains its enhancement settings.

  Go to Element – Selects the layer corresponding to the selected element in the Layers palette. If the selected 

element has been enhanced, the enhanced layer is selected instead.

  Add Targeted Element – Adds the currently selected qualified layer in the Layers panel to the Elements list.

  Remove Element from Dashboard – Deletes the selected element from the Dashboard. Enhancement options 

and enhanced layers are also removed.

5 The GTIN-14/UPC-E/GIAI field displays the Digimarc Barcode associated with this document. A green check mark 

indicates a valid GTIN-14, UPC-E, or GIAI; a red X indicates an invalid or incomplete value. The Barcode Resolution field 

displays the Digimarc Barcode Resolution previously selected in the Barcode Details. Click Back to view the Barcode 

Details.
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Enhancement Options
The Enhancement Options window presents a choice of Enhancement Techniques: Multi-Channel, Single Channel, or 

Binary. The available Enhancement Parameters change depending on the chosen technique. The multi-channel technique 

is available only if a process color element is selected. The single channel and binary techniques are always present.

Multi-Channel Enhancement

1 Select the Multi-Channel technique, and then select  

the color channels to enhance: CMY, CMYK, or MYK. 

Dots in the upper-right corner indicate the selected 

channels.

2 The Enhancement Parameters are:

 - Strength – Controls the strength of Digimarc Barcode. 

When enhancing at 150 WPI, the strength slider 

displays values in half-strength increments from .5 

to 10. At 75 WPI, the strength slider displays whole 

values from 1 to 10.

 - Minimum Dot % – Specifies the minimum dot as 

supplied by your printer.

 - Reduce near Min Dot – Compresses a range of 

pixels based on a preset curve. Based on the setting 

compression is applied as pixels approach min dot, 

creating a blending effect in a specific range using the 

following formula:

Off: No compression

Low: (Min dot * 2) + 5 

Medium: (Min dot * 2) + 10

High: (Min dot * 2) + 15

 - Protect Zero Ink – Controls whether enhancement is applied in areas the color of the substrate.

 - Reduce in Highlights – Available for CMY enhancement only, this option minimizes enhancement in highlight areas. 

This reduces the need for art elements to go through an additional step of highlight reduction in Photoshop after 

enhancement in Illustrator.

 - Custom Data – Select the Custom Data for the selected element from the drop-down menu. If there is only one 

custom data entry, it is automatically selected. 

NOTE: The Custom Data drop-down is only visible if the barcode type is Packaging + Custom Field.

3 Click Apply to enhance the selected element; click Cancel to exit.
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Single Channel Enhancement

1 Select the Single Channel technique, and then select  

the channel to enhance. 

2 The Enhancement Parameters are:

 - Strength – Controls the strength of Digimarc Barcode. 

When enhancing at 150 WPI, the strength slider 

displays values in half-strength increments from .5 

to 10. At 75 WPI, the strength slider displays whole 

values from 1 to 10.

 - Minimum Dot % – Specifies the minimum dot as 

supplied by your printer.

 - Reduce near Min Dot – Compresses a range of 

pixels based on a preset curve. Based on the setting 

compression is applied as pixels approach min dot, 

creating a blending effect in a specific range using the 

following formula:

Off: No compression

Low: (Min dot * 2) + 5 

Medium: (Min dot * 2) + 10

High: (Min dot * 2) + 15

 - Custom Data – Select the Custom Data for the selected element from the drop-down menu. If there is only one 

custom data entry, it is automatically selected. 

NOTE: The Custom Data drop-down is only visible if the barcode type is Packaging + Custom Field.

3 Click Apply to enhance the selected element; click Cancel to exit.

Binary Pattern Enhancement

1 Select the Binary Pattern technique, and then select  

the channel to enhance. 

2 The Enhancement Parameters are:

 - Positive/Negative – Select either a negative binary 

pattern (White dots on black) or a positive binary 

pattern (Black dots on white).

 - Dot Density – Set the density of the dot pattern.

 - Dot Size – Set the size of the dot pattern.

 - Custom Data – Select the Custom Data for the 

selected element from the drop-down menu. If there 

is only one custom data entry, it is automatically 

selected. 

NOTE: The Custom Data drop-down is only visible if the bar-

code type is Packaging + Custom Field.

3 Click Apply to enhance the selected element; click 

Cancel to exit.
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Applying Enhancement
When you click Apply in the Enhancement Options dialog:

• The layer in the Layers palette that corresponds to the selected element is duplicated and the new layer has _DM 

appended to its name.

• Digimarc Barcode is applied in the duplicate layer. 

• The original layer is unchanged.

If enhancement succeeds:

• The enhanced duplicate layer is retained.

• Any previously enhanced layer associated with the same original artwork is deleted.

• The Dashboard is updated with any changes made to the enhancement technique and parameters in the Enhancement 
Options dialog.

If enhancement fails:

• An alert appears informing you of the reason.

• The duplicate layer is deleted.

• Any previously enhanced layer associated with the same original layer is untouched.

• The Dashboard is not updated with changes made in the Enhancement Options dialog.

Additional Notes

• The elements and settings in the Dashboard are retained when the document is closed.

• The list of elements in the Dashboard is kept up-to-date regarding changes to the Layers palette. For example, if a 

layer corresponding to an element in the Dashboard is deleted from the Layers palette, the element is deleted from the 

Dashboard.

Known Limitations
To avoid placing the artwork file in a state that exposes known issues, it is critical that designers finalize the artwork design, 

layout, and layer structure before using the extension. The following post-enhancement workflows should be avoided:

• PPI adjustments and image scaling. To qualify an element for enhancement, elements must be rasterized at 300ppi and 

must not be scaled after enhancement.*

• Undo (Cmd + Z)*

• Deleting the original layer or separating it from the enhanced (DM) layer* 

• Color correction

• Unembedding enhanced links

• Embedding outside-enhanced links from other applications such as Photoshop

NOTE: Items marked with * are most relevant to prepress operators.
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+1 800 DIGIMARC 
www.digimarc.com/help 
support@digimarc.com 
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Digimarc Color Advisor
Digimarc Color Advisor is an additional tool provided by Digimarc for Packaging to assist production designers and 

prepress specialists in selecting the best spot colors with which to enhance packaging with Digimarc Barcode or how best 

to work with a given spot color for readability by barcode scanners. These recommendations do not cover readability on 

mobile devices.

Open Digimarc Color Advisor by navigating to Window > Digimarc > Digimarc Color Advisor

When you select a spot color, Digimarc Color Advisor displays the suggested technique for enhancing that color with 

Digimarc Barcode. The Digimarc Color Advisor contains data for spot colors from the PANTONE+ Solid Coated or 

PANTONE+ Pastels & Neons Coated swatch libraries (PANTONE GP1501 Plus Series Formula Guide Coated or PANTONE 

GG1504 Plus Series Pastels and Neons Coated).

NOTE: Digimarc Color Advisor is currently optimized for enhancing at 75 WPI and results may vary when enhancing at 150 WPI.  

Definitions

• PANTONE® Color Name: The PANTONE MATCHING  

SYSTEM® is a tool allowing for the faithful selection, 

articulation, and reproduction of consistent, accurate 

color anywhere in the world. The tool organizes 

color standards through a numbering system and 

chip format.

• Strength: The suggested technique assumes 

a default strength of 5. Use the slider to view 

suggestions for other enhancement strengths. Some 

colors may be enhanced better at certain strengths.

• Red Light Contrast: Given as a percentage, this is 

the difference in reflectivity between paper white 

and solid ink of the light (660 nm wavelength) 

transmitted by barcode scanners. Contrasts 

between 20% and 80% indicate more easily 

enhanced colors. 

• Suggested Technique: This is a suggested starting 

point for working with a particular tint, based on 

offset printing on white, coated paper, and assumes a GRACoL2006 profile. You may want to experiment with what 

works best for your particular color, substrate, and printing environment. 

 - Spot Direct: Screened: This process varies the percentage of ink applied within areas covered by the spot color.

 - Process Overprint: Multi-channel: This process adds low percentages of cyan, magenta, and yellow (CMY) inks over 

the spot color. The suggested CMY tints are listed as well as the DeltaE.  

 - DeltaE: DeltaE refers to how noticeable the difference is between the overlay and the original spot color, where a 

DeltaE of 2.3 is just noticeable and higher DeltaE values are more noticeable. 

NOTE: DeltaE is shorthand for the standard CIE ΔE*
ab, which is the Euclidean distance between two colors in the perceptu-

ally uniform device-independent color space, CIELAB. 

http://www.digimarc.com/help
mailto:support%40digimarc.com?subject=
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